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Matlab commands can be placed in a file for repeated
execution

Such files typically use the extension ‘.m’
Files can be created in any text editor
Create a new file in Matlab’s editor in the File menu

<) MATLAB

File Edit Yiew Web Wwindow Help

Qper, ., kel Figure
Close Command Window kel IModel

GUI

Impart Data...
Save Workspace As...  Chrl+S

Sek Path...
Preferences. ..
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Print Seleckion ..

Exit MATLAE Chr+c
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* The resulting window is the Matlab Editor/Debugger
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Scripts - Context Scripts - Demo
Programming | o A gcript executes as if typed from the command line Programming | o A demo script created in the Editor/Debugger
Scripts Scripts . . .
S » Same context ) * Line numbers automatically included
unctions Functions
Debugging — variables defined in the Command Window are visible Debugging » Comments begin with ‘%’
Conditional = tb‘;fcnpt P Eveention” |+ Save As... to be able to execute the script -
Visualization I Ciﬁatlco B e in the seript witl be Visuslization B) H'\ Instruction|MatlabTutorial\Demos _lol x|
2-D Graphs VARl T CLER SR 10 S 2-D Graphs File Edit Wiew Text Debug Breakpoints ‘Web ‘Window Help
3-DGraphs | * No parameters can be passed to a script 3-D Graphs :
i P P P i DEES&G o #@H | 88 x
Graphs  No return values can pass from a script Graphs 1 % Demo script File -
Presentation Presentation 2 % hzsume wariable & iz already defined
3
4= | mwmyResult = 4 + &
]
B % Change the walue of 4
7
B - A = l; -
d [ I_I
Ready
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Scripts - Execution Scripts - Current Directory
Programming | « Type the script name to execute it Programming | '« Tq execute, the script file must be:
Script . : . Script . .
s « Script output appears in the Command Window - — in the current directory, or
Functions . Functions ) ) )
Debugging . Pr_ess <Ctr1>.- C.to stop execution of any command Debugging — 1in a directory in the search path
Eo el prior to termination Conditional | « The Current Directory panel shows the contents of the
Execution Execution di d1 h he 1 .
STt ST o current directory and lets you change the location
2-D Graphs 2-D Graphs » Double-click an M-file to open it in the editor
3-D Graphs >> A=5; : 3-D Graphs Currert Directary
Savin >> DemoScript Savin | H:\ Instruction\MatlabTutorial v | J| ok | i
Graphs myResult = Graphs A4ll files File Type Last Modified
Presentation Presentation Eo "
Dﬂatlab.doc 07-Sep-2001 11:1(
[l #atiab.pas 07-Sep-2001 11:]
[#] matlab_tutorial... 21-Jan-2000 12:1(
DMatlab_Tut,Drial. . 13-%ep-2001 01:
D.Hat,lab_’[‘ut,m:ial. . 13-%ep-Z001 01:!
D.Tut,orialSlides_. . 07-Sep-2001 12:!
DTut,orialSlides_. . 07-Sep-2001 12:!
1 | -l
4| by Im Current Directary I—
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Scripts - Search Path

Functions - Context

Programmin :
ogramming | « To examine the search path, open Set Path
Scripts . .
) » To update the path in a script, use addpath
Functions
:
Debugglng File Edit Wiew ‘Web Window Help
Conditional gew o '
Execution CI‘:::Eurrent Direckary Ct:l:w _I
PETTEEE— 1o x
Visualization Impart Da[::"' I All changes take effect immediately.
Save Workspace As..,  Chr4+5
2-D Graphs SERRain MATLAB seatch path:
3-D Graphs Preferences. .. Add Folder | (A HAnstructiommatiabTutorial o
. citem
Savin Rt il Add with Subfolders | a i "
Grap S Print Seleckion.. &
. CApimatiabr! Xtoalbodmat21 7
Presentation L GRS i) —— (3 Pimatiabr Ztoolbodmatiabigeneral
CAPwnatiabr 2toolboxdmatiabiops
Moye Lp [ Pamatiabrl Ztoolboamatiabilang
(3 Finatiabr! Atoolboximatiablelmat
Remoye
CaPwnatiabr 2toolboxdmatiabielfun
aove Dowh CAPwnatiabr Xtoolbodimatiaspecfun
(3 Fimatiabr! Atoolboximatiabimatfun
Move to Botior (3 Pimatiabr! Ztoolbodmatiabidataiun
Doenmtl Akt Titaalbsadra st biaodin hd
ki | _>l_I
Save | Close | Revert Default Help |
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Programming | o A function is a special type of M-file
Scripts .
I » Different context
unctions
Debugging — variables defined in the Command Window are not
Conditional visible in the function
Execution . . . . . .
o — variable creation/changes/clearing in the function will
Visualization .. . .
not be visible in the Command Window
2-D Graphs
3-DGraphs | * Parameters can be passed to a function
%arvalf,' . — Parameters are passed by reference unless they are
Presentation modified within the function
— You cannot force pass by reference nor are data pointers
supported
— Matlab does support global variables (global) and simple
context switching (evalin, assignin)
* Return values can pass from a function
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Functions - Demo

Functions - Invoking

Programming
Scripts
Functions
Debugging
Conditional
Execution

Visualization
2-D Graphs
3-D Graphs

Savin,
Graphs

Presentation

* Function files begin with the syntax:
function [retl, ret2, ....] = myfun(paraml,param?2,....)

» Comments immediately after the declaration appear in
the Command Window when you type ‘help myfun’

B} H:\Instruction’MatlabTutorialDemoFunction.m = |EI|1|
File Edit View Text Debug Breakpoints ‘Web ‘window Help
DEEHS| s =eoc|(an| @R E0E R8s ox
1 function [r_sum,r_diff] = DemoFunctionip_a,p_b) 1=
2 5
3 % Thiz function returns the sum and difference
4 % between the two parameters.
5
B-| r_sum =p_a+ p_b;
7|=| r_diff = p a - p_b:
8 =
4 [
Ready
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Programming | « [nvoke the function like any other Matlab function
Script: . .
N * To accept multiple return values, place them in square
Functions
brackets [ ]
Debugging
Conditional
Execution
Visualization
2-D Graphs
3-D Graphs >> help DemoFunction
Savin,
Graphs This function returns the sum and difference
Presentation between the two parameters.
>> [theSum, theDiff] = DemoFunction([1 2 3],1)
theSum =
2
theDiff
0
EE Matlab Tutorial II: Programming and Visualization 12




Debugging - Set Breakpoint

Debugging - Control

Programming | o The Editor/Debugger also allows interactive debugging
int . .
Seripts of functions and scripts
Functions . .
Der TN * Move the cursor to the line debugging should start and
Conditional click the Set/clear breakpoint icon
Execution
Visualization
2-D Graphs
3-D Gl‘aphS B} H:\InstructioniMatlabTutorialiDemoFunction.m =10l x|
Savin: File Edit “iew Text Debug Breakpoinks ‘Web Window Help
Graps. DD”'H§|¥JE.nm|“f}j@ﬁ|@@@fl@@|8taw:laase 'lll
Presentation 1 function [r_sum,r_diff] = DemoFunction(p_a,p_b) =
3| | =
3 % This function returns the sum and difference
4 % between the Lwo parameters.
5
| Ir_su.m =p_a+ph;
7l=| r_diff =p_a - p_bh:
8 =
1 [
Ready
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Programming |« The debugger provides control over execution
Scripts . 5
. #3] — executes the current instruction
Functions
Debugging %3 — jumps into a subroutine
Conditional )
Execution [2f — executes through the end of a subroutine
Visualization g .
3] — continue execution
2-D Graphs
3-DGraphs | $31 — stop debugging
Savin
Grap S B} H:Instruction’,MatlabTutorialiDemoFunction.m 1Ol =|
Presentation File Edit Yiew Text Debug Breakpoints ‘Web Window Help
O ﬁn§| % Bz w m|Mf> | @ﬁl@@@j@@| Stak: [DemoFunction x|
1 function [r_sum,r_diff] = DemoFunction(p_a,p_b) =
2 | =
3 % This function returns the sum and difference
4 % between the LwWo parameters.
5
G| & (e lr_su.m =p_a+ p_h;
T|=| r_diff = p_ a - p_b:
; K
4 [
Ready
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Debugging - Variables and Errors

Debugging - Command Window

Programming
Scripts
Functions
Debugging
Conditional
Execution

Visualization
2-D Graphs
3-D Graphs

Savin,
Graphs

Presentation

» Pausing the pointer over a variable shows its value

B} H:\ Instruction’,MatlabTutorial',DemoFunction.m

—loj x|

File Edit view Text Debug Breakpoints eb ‘Window Help

DSEE| s E2ro e fap| B[P DD | stk oemorunaion x|

1 function [r_sum,r_diff] = DemoFunction{p_a,p b &

2 5

3 % Thiz function returns the sum and difference

4 % bhetween the two parameters.

5

Gl®er r_sum = p_a + p_h;

Tl = r_diff = p_a - p h:

8 p_a-= -

q] 1 z 3 | »

Ready

» Breakpoints can also be set for errors, etc.

B} H:\InstructionMatlabTutorial,BemoFunction.m

File Edit ‘Wiew Text Debug | Breakpoinks Web Window Help
SetfClear Breakpoint F12
Clear all Breakpoints

Stap IF Error
Stop IF Warning
Stop IF Mam Or Inf
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* Command Window prompt changes when debugging
* You can evaluate expressions in the function context

* You can change the value of parameters and local
variables
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Conditional Execution - Logical Arrays

Conditional Execution - if Construct
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» Some operators return logical arrays
* Logical arrays can be operated upon like floating-point
» Bitwise operators are:
& - AND
| -OR

>> (D>2) & (D<4)

ans =
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* Construct
if expr
statement1
else
statement2
end

executes statementl if all elements of expr are non-
zero, otherwise statement2 is executed

>> if (D>3)
disp('All elements are greater than three');
else
disp('Some elements are not greater than three');
end
Some elements are not greater than three
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Conditional Execution - for Construct

Conditional Execution - while Construct
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* Construct
for var = expr
statements
end

assigns columns of expr to var in turn

>> for v=1:5
disp(v) ;
end
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* Construct
while expr
statements
end

iterates until all elements of expr are zero

>> A=0;
>> while A ~= 5
disp(3) ;
A=A+ 1;
end
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2-D Graphs - Figure Windows 2-D Graphs - Plotting
Programming | « (Create a figure window with ‘figure’ Programming | « Make a plot in the current figure window with ‘plot’
Script: Script : :
cripts + The figure command returns a handle for later use R — First parameter is an array of X values
Functions X Functions 5 E 1
pebugging | * Also use figure(H) to make H the active figure Debugging — Second parameter is an array of Y values
conditional | * Use close(H) to close figure H Conditional — Third parameter can specify a color and line style
Execution Execution
Visualization Visualization
2-D Graphs 2-D Graphs
3 : ] l=IE
3-D Graphs >> myFig = figure 3-D Graphs >> theta=0:0.2:2*pi; Flo Edt Yew Isert Tods Widow Hep ~ol
. . >> plot(theta,sin(theta)) lbpemalyars2pn
Savin myFig = Savin
Graphs Graphs 1
Presentation 1 Presentation e
06
myFig2 = figure; 04
% This will bring myFig forward and make it active o
figure (myFig) v
0.2
% This will close myFig2 04
close (myFig2) a6
-08
T 1 2 3 4 5 6 7
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2-D Graphs - Overlaying Plots 2-D Graphs - Overlaying Plots
Programming ° Slmply plottlng agaln Wlll replace the Old plot Programming =10l %]
Scripts ' ' . Scripts File Edit WYiew Insert Tools Window Help
_ » To overlay a plot, use 'hold on'. To replace again, use ) lDsEa@ xAA A/ @220
Functions 'hOl d 0 ff Functions
Debugging o Debugging
Conditional * >>hold on Conditional
Execution o >> pl ot(theta,sin(theta),'r') Execution
Visualization Visualization B
2-D Graphs 2-D Graphs |
3-D Graphs >> plot(theta,cos(theta), 'g"') 3-D Graphs
. >> hold on q 1
Savin >> plot (theta,sin(theta),'r"') Savin
Graphs Graphs
Presentation Presentation
7
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2-D Graphs - Labeling Plots

2-D Graphs - Labeling Plots

Programmin ‘ ith axis(IX_. | B i5ix]
Sg int g ® Change axis ranges Wlth aXlS([Xmm’ Xmax? Ymm’ Ymax]) Sg it = File Edit Wiew Insert Tools ‘Window Help
Ol  Always label a plot with legible information Wl B EEY YR
Functions . Functions . .
. — Title text . Sine and Cosine values
Debugging ) Debugging : : . : :
Conditional — Legend if more than one plot Conditional Cosine
[ — Labels for X and Y axes o —— e}
Visualization Visualization
2-D Graphs 2-D Graphs
3-D Graphs >> title('Sine and Cosine values', 'FontSize', 14) 3-D Graphs &
. >> L = legend('Cosine','Sine'); . =
%?““ >> xlabel ('Angle in Radians', 'FontSize',12) %?““ D
Eapis >> ylabel ('Function Value', 'FontSize',12) raphs =
Presentation Presentation -%
S 02t
o
04F
06+
08F
= 1 I
0 1 2
Angle in Radians
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2-D Graphs - Subplots 2-D Graphs - Subplots
Programming ° Tlle more than one lot ln a ﬁ ure Wlth Programming =lolx]
p g File Edit Wiew Insert Tools ‘Window Help
Script: Script:
Ol subplot(rows, columns, current) cripts DeEga "A2/ 2o
Functions . Functions
Debugging » Make polar plots with polar(theta, rho) Debugging
conditional | ¢ Plot discrete sequence data with stem(X, Y) Conditional
Execution . . . Execution
o » Make piecewise constant plots with o
Visualization Visualization
2-D Graphs 2-D Graphs
3-D Graphs myFig2 = figure; 3-D Graphs
%?ﬁ“ % First we make a polar plot... %?ﬁ“
Lapis subplot(2,1,1) raphs Palar Plot Example
Presentation title('Advanced Plotting', 'FontSize',14) Presentation

polar (theta,l-sin(theta)) ;
xlabel ('Polar Plot Example', 'FontSize',12)

)

% ...then we add a stem plot...
subplot(2,1,2)

stem(theta,cos (theta))

xlabel ('Sample Location', 'FontSize',12)
ylabel ('F[n] ', 'FontSize',12)
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2-D Graphs - Other Plots and Editing

3-D Graphs - Plotting

Programming | « Matlab provides many other two-dimensional graphs
Seript:
mp.s bar( ) creates bar charts
Functions . .
Debugging — pie( ) creates pie charts
l%ondi:ional — loglog( ) creates plots with logarithmically space axes
xecution
Visualization - semﬂ_ogx(_) and semilogy( ) create plots with one axis
2-D Graphs logarithmically spaced
3-D Graphs
Savi . . .
Craphs » Use the Edit Plot tool to select items in a plot
Presentation

— double-click axes, plots, etc. to change their properties

<} Figure Mo, 2

File Edit Miew Inserk Tools ‘Window Help

DEE&E YA A/ 2ED
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Programming |« [Jse ‘plot3’ to plot three-dimensional curves
Scripts — First parameter is an array of X values
Functions 2
Debusei — Second parameter is an array of Y values

ebugging . .
Conditional — Third parameter is an array of Z values
Execution

Visualization
2-D Graphs
3-D Graphs >> figure

. >> theta2 = 0:0.2:(20*pi);
Savin >> plot3 (theta2,cos(theta2),sin(theta2))
Graphs
Presentation
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3-D Graphs - Plotting 3-D Graphs - View Direction
SECCIanIYY —— Programming [« [Jge the rotate tool to change the viewing direction -
Scripts File Edit Wiew Insert Tools Window Help Scripts 1. k d d Rk h 1
) IEEERY Y ) click and drag 1n the plot
Functions Functions <} Figure No. 2
Debugging Debugging File Edit View Insert Tools ‘Window Help
Conditional Conditional ~u —
Execution Execution H DedS | A A | AR D
Visualization Visualization e TR =k}
2-D Graphs 2-D Graphs losmalx a2 280
3-D Graphs 3-D Graphs
Savin, Savin,
Graphs Graphs
Presentation Presentation
Az 2HEL 32
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3-D Graphs - Mesh Plots

3-D Graphs - Mesh Plots

Programming Use ‘mesh’ to plot three-dimensional wire-frame i i a0l
. . File Edit Yiew Insert Tools ‘Window Help
Scripts Surfaces Scripts JJD = o §| XA | ® 5
Rt — First parameter is a matrix of X values B 3D Mesh Plot
Debugging S q g Debugging
" — Second parameter is a matrix of Y values i R
Conditional . . . Conditional
Execution — Third parameter is a matrix of Z(x,y) values Execution
Visualization » Create evenly spaced coordinates with ‘meshgrid’ Visualization s
2-D Graphs 2-D Graphs
3-D Graphs figure 3-D Graphs 0.5+
. [X,Y] = meshgrid(0:0.1:2*pi) ; .
Savin mesh (X,Y, cos (X) . *cos (Y)) Savin &
Graphs Graphs = 0o
Presentation xlabel ('\theta 1', 'FontSize',12) Presentation = \
ylabel ('\phi 2', 'FontSize',12)
zlabel ('F(\theta 1,\phi_2)', 'FontSize',12) s g :
title('3-D Mesh Plot', 'FontSize',6 14) g :
! it ki
151, oy :
B \\\\\g““.‘s:’:::??’ 3
4 T
4
0o
b, 8,
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3-D Graphs - Surface Plots Saving Graphs - .fig Files
Programming | '« [Jge ‘surf” instead of mesh to fill the plot with color Programming | o Figure saving and exporting are available through the
Scripts . . . Scripts D
S » Use ‘shading interp’ to interpolate the color smoothly ) figure’s file menu
unctions 2 Figurelont _iojx] Functions _
Debugging File Edit ‘iew Insert Tools Window Help Debugging File .
Conditional lDz@g/xars(pan Conditional E?:HFIII-;Iure Et:::g
Execution 3-D Surface Plot Execution Closs Ctrlew
Visualization S Visualization . Ctri+3
2-D Graphs e L 2-D Graphs Save As...
3-D Graphs I3 e N 3-D Graphs Expatt...
Savin . é Savin Preferences. ..
Graphs 054 o / Graphs
Presentation = . y & Presentation PR el B
T 0 : Tl Print Setup. ..
% ' Print Preview. ..
05 Print... Ctrl+P
» ‘Save As...” enables you to recreate the figure later
— be sure to specify a file extension ‘.fig’
* Recreate the figure with the ‘Open...” menu command
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Saving Graphs - Exporting

Presentation - Microsoft Office

Programming | '« Export saves a graphic file in one of many formats for Programming | '« Tn Microsoft Word or PowerPoint, insert a graphic into
int: o g 3 int:
Seripts use in other applications Scripts your document from the ‘Insert’ menu
Functions 2 Functions
Debugging Savein | (= MatlsbTutorisl |« ® ek E Debugging lnse;t .
Break...
Conditional Conditional Page Numbers. ..
Execution Execution o
Date and Time. ..
Visualization Visualization AutaText >
2-D Graphs 2-D Graphs Eeldb'“l
moal. ..
3-D Graphs 3-D Graphs 5 Eimment
Savi Savi
(;T;ll,l S File name: [+ Save I G;i"g;l[l)l S Footnote...
Presentation Save as type: IEnhanced metafiles(*. emf] | Cancel | Presentation Bl
IEnhanced metafiles(* emf) = Cross-reference. ..
Bitmap files(*.bmp) — Index and Tables. ..
EPS files [".eps]x e
ool o I ..
PRI R
JPEG images F'l-e_"' @ autoshapes
TIFF no compressian images(* tif] LI . . Obiject... ‘ Worddrt,..
« TIFF and JPEG are useful for including in Word, a e & teworauing
. wpetlink. . . tl-+H
PowerPoint, and WWW documents g:mfca“”e' or Camera..
har
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Presentation - Microsoft Word Layout Presentation - LaTeX
Programming | '« Double-click the graphic and choose the ‘Layout’ tab Programming | '« Exporting a graphic as encapsulated PostScript (EPS)
int: 9 int: 3 3 g
Seripts to select text wrap options Scripts is very useful for preparing typeset documents as with
Functions Functions LaTeX
Debugging Format Pickure ed | Debugging alc
Conditional Colors and Lnes | Size Picture | Textbox | web | Conditional In the preamble of your LaTeX document, type
E ti ] E ti .
xecution Wrapping style xecution \reemeeeme lepaie
Visualization = Visualization . L
2-D Graphs o N r = ba d 2.D Graphs To create a floating figure within your document:
3-D GraPhS In line with bext Sguare Tight Behind text  In front of text 3-D GraPhS \begln{ £ igure }
Savin Savin begin{center
Graphs Horizontal alignment Graphs \ g { }
Presentation  Left € Cenker € Right & Other Presentation \begln{ tabul ar} {C}
\psfig{figure=SurfaceColor.eps,width=5in}
\end{tabular}
\end{center}
\caption{Surface plot of my function.}
Advanced. .. | .
\end{figure}
Ok I Cancel I
EE Matlab Tutorial II: Programming and Visualization 39 EE Matlab Tutorial II: Programming and Visualization 40




